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2. Seating Charts

3. Student Information

Advanced Studies
Geometry

MAB)
Baze, Madelynn

Bilton, Anna

Clausen, Kaylie -
Donaldson, Anna
Gardner, Michael
Gavin, Jack

Gerber, Emily

Gerling, Sophia

Giiffin, Alexis

Keary, Alexander
Litton, Elizabeth
Londre’, Gilbert

Loyd, Carter

Root, Jeremy

Russell, Javin
Scarborough, Jeffrey
Scarborough, Meredith
simpson, Helen
‘Wascom, Tyler
Weeda, Trey

‘Wilsen, Joshua
‘Winston, Zakiyyah
Wiseman, Shelby
Witmer, Brock

Wood, Madison
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School:
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Course Teacher Room  Enroll
Advanced Studies Geometry RINEY, ANNE 1122 08/20/2014
Spanish Il BRIZUELA, HANNAH 2169 08/20/2014
Concert Orchestra KEENEY, JOSEPH 1189 08/20/2014
Advanced Studies English 9 HAESEMEYER, MINDY 2103 08/20/2014
Advanced Studies Biology CHARPIE, AMY 1301 08/20/2014
9th Grade Women's Choir PERRY, STEVE 1190 08/20/2014
Advanced Studies American History COLLIS, JUSTIN 2114 08/20/2014
BRANCH, MICHELE 2119 08/20/2014

Use the drop down menu, to select

Demographics - for parent information

Quick Lookup - student schedule, current grades, etc.
*Feel free to click any of the options to view additional information

Lee's Summit North High School

Leave
01/01/2015
01/01/2015
01/01/2015
01/01/2015
01/01/2015
01/01/2015
01/01/2015
01/01/2015



4. Reports
Power-reaCher School: Lee's Summit North High School ~ Term: 14-15 Semester 1

welcome, ANNE RINEY | Server PSAPP3V Help Sign Out

Navigation 1

S — R7 Teacher Reports by Course
Daily Bulletin

Schedule Report Description

Staff Directory Class Attendance Audit Report  Displays attendance for each student in the class. PLEASE BE PATIENT AS THIS REPORT TAKES A WHILE TO GENERATE

Personalize
— Guardian Email Address Report Displays guardian email addresses for each student in the class (MS Word format)
LSR7 Reports Student Email Address Report  Displays student email addresses for export (MS Word format)

LSR7 Student Directory
Recommendations

Teacher Email Address Report  Displays teacher emails for students in class for export (MS Waord format)

N Student Data Report Displays student last name, first name, and student number in class for export (MS Excel format)
choolne!

Guardian Email Address Report — compiled list of parent emails for that class. In Lotus, you
can create a group contact and copy the emails addresses into that group. *When
emailing a group of people, use BCC. Click on the other links to view the information.

5. Discipline —to write a referral on a student, click on the scales. Then click a student’s
name.
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Start Page
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SELELLLY Bilton, Anna Rose
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Schoolnet

Gardner, Michael R

New Gradebook Launch Gavin, Jack

Run Installer once, then Gerber, Emily Katherine

Geriing, Sophia L

Griffin, Alexis Leona
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Launch Keary, Alexander Christian

Litton, Elizabeth Marie

LSR7 Reports:
Power:reaCher School: Lee's Summit North High School ~ Term: 14-15 Semester 1

Welcome, ANNE RINEY | Server: PSAPP3V Help Sign Out

Navigation B Y R7 Teacher Report
S e eacher Reports
Daily Bulletin
Schedule Report Description
Staff Directory Student Medical Alert Report Student Medical Alert Information by Course/Section
Personalize

Student ADA Percentages by Course Student ADA percent for the current semester by Course/Section
Gradebook :
LSR7 Reports Student Tutoring Information by Advisor Students listed with their tutoring information (LSWHS Only).
LSR7 Student Directory Student Attendance Code Summary Listing Students listed with the various attendance codes and total number of occurrences
Recommendations

Schoolnet



You will need to generate the Student Medical Alert Report and print a copy for you and

your emergency sub plans. You may also click on the other links to generate the other
reports.

SchoolNet: Thisis a link to SchoolNet to view course curriculum.

Lauching Gradebook: Follow attached instructions (PowerTeacher Installer)
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Working with the Gradebook

The table below provides a brief explanation of the tabs teachers see in a row at the
top of the gradehook window.

Scoresheet Displays the assignments and scores entered for students
Assignments Displays the details of the assignments you have created
Students Displays demographic data for students in the class

Grade Setup Displays the final grade setup for each term plus access to

editable grade scales

Displays information about the selected course, plus access to

Class Content ! . T
collections of web links and other resources

Reports Provides an interface to choose and format reports




Setting Up Categories
Categories are broad classifications in which similar types of assignments are

grouped. Examples of pre-defined categories are Homework, Test, Project, and
Quiz. Teachers can add additional categories and/or modify the default categories.

Activity 2 — Adding Categories
Add two categories to your PowerTeacher gradebook.

1. From the Tools menu, choose Categories. The Categories window will
appear, displaying the pre-defined assignment categories.

2. Click the Plus (+) in the lower left-hand corner of the Categories window to
add a new category.

3. Provide a name for the category and choose the color for its label. Enter in
the number of points possible, and choose a score type: Points, Letter Grade,
or Percentge.

4. Select Include in Final Grade unless the category is something ungraded,
like draft assignments or permission slips.

5. Click the Plus (+) to add the second category.

6. Click Close to save and close the Categories dialog hox.

*Make sure that categories are set to pubilish.

Edit Assignment Category
Specify attributes of the Assignment Category

Name: | ST

Abbreviation: |HW

Color: rf(ﬂl Violet v:

These options will be applied as defaults to any new assignments when
created for this category.

Points Possible: 5
Extra Points: |0
Score Type: 'Points v.
Include in Final Grade: . -
Publish Assignment: jImmediater vi

On Date: | pnjddjyyyy
Days Before Due: |0

Publish Scores:

Description:

Setting Up Final Grade Calculations

After teachers create assignment categories, they need to determine how the
students’ final grades will he calculated for each term by total points, term weights,
or category weights.

**Grade set up — meet with mentor/dept chair
Once you have set up final grades, you can copy the grade set up into like courses.
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You can also find the dates that you MUST use for your final and for your EOC on this screen.
In order for PG to calculate the score properly, you MUST use the dates you will find on the
Grade Setup.



Assignments

Teachers can set up assignments at the beginning of a school term or at any time
during the term. Assignments are displayed on the Scoresheet tab. The name, point
value, and date due for each assignment appear above the column in which student
scores are entered. Double-clicking an assignment heading (or clicking the arrow at
the top) opens the assignment definition window where you can modify the
assignment or publish criteria.

As you enter assignments, you will notice a demarcation line that separates future
assignments from past assignments. Posting assignments before entering scores
does not skew how grades appear. The Final Grade that appears next to the
student’s name on the Scoresheet reflects an average grade for only the
assignments that have already been scored.

Publishing Assignments

When you publish an assignment parents and students can see it in PowerSchool’s
parent and student portals. You can publish an assignment when you are create it,
or at any point afterward. PowerTeacher gradebook defaults to publishing
assignments as soon as they are created.

If an assignment is part of the student’s final grade, it must be published at some
point. You will receive an error message if you choose the Never publish option for
an assignment that is to count toward the final grade.

One advantage of publishing assignments in advance of their due date is that
parents can see that there are upcoming projects due or tests to study for, and you
can enlist parents to help make sure students are prepared.

Activity 8 — Creating a New Assignment

1. While on the Scoresheet tab, click the Plus (+) sign next to the Assignment
header to open the New Assignment pane.

2. Enter a name for a homework assignment and choose Homework as the
category. Set a due date to today and determine whether yvou wish to accept
the default values for score type, points, and extra points. Choose to include
the homework assignment in the final grade. Enter a brief description.

3. Click the Publish tab. Choose when to publish the assignment.

4. Click Save in the lower right corner to save the assignment. The assignment
will appear in the Scoresheet. Repeat the steps for a second and third
homework assignment.

Copying Assignments

You can copy assignments from one class to another from current or previous terms
by using the Copy Assignment function in the Tools menu at the top of the screen.

Activity 9 — Copy Assignments

1. First select the class to copy assignments from in the classes menu located in
the upper left corner of the gradebook.

Then select Copy Assignments from the Tools menu.
Choose an assignment to copy and click Next.

Choose one of your other classes.

[ 3 I < S T A

Select Today from the Due Date menu and click OK.



6. Click on the class you copied the assignment to in the classes menu to view
the assignment.

Additional Information:
Click on Tools — Preferences — Grading. Make sure you window matches with the window
below.
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Click the Score Codes tab. The codes listed below are optional...however, talk with your
department. Codes should be kept as universal as possible, so that there is less confusion
when parents are viewing their student’s scores.

2
Preferences '3 S | |

|[-Comment Bank | Grading | Mai | Score Codes | Section | Spell Check | Standards | Student|
I

Score codes can be used to score assignments and assignment standards, They can not be used for final grades.

The following score codes are available:

Code Description Yo Mumeric
Ab Absent ] 0 &
E Excused Ex Ex
H Homebound 0 0
L Late a 0
M Mot Turned In 0 0

Edit Delete




Using the Score Inspector

Just like the quick-entry methods, the Score Inspector makes it possible to indicate
if an assignment was received late, a student is exempt from completing the
assignment, an assignment is missing, or you have collected the assignment
without entering a point value. You can also use this tool to enter a score comment.
The following table provides a brief explanation of the assignment indicators

displayed in the teacher’s gradebook.

Indicator Description

Indicator Meaning

Small “C” in blue dot next to score

Comment is attached

Small "L” in red dot next to score ®

Assignment turned in late

Small "M" in orange dot next to score

Assignment is missing

Green check in a cell ¥

Assignment turned in but not graded

Indicator Description

Indicator Meaning

Ttalicized faint score

Assignment does not count toward
final grade OR was marked as
exempt after scoring

Small Hourglass in assignment heading Z

Assignment published on certain
date

Circle with line through it in assignment
heading ©

Assignment is never to be published

Small red exclamation mark next to
italicized final grade ©

Final grade changed by manual
override

Yellow exclamation mark in the
assignment heading &

Scores are not published

Small "G” in gray dot next to student
name =

Student is assigned a grade scale
other than default




Activity 12 - The Score Inspector

Use the Score Inspector to add score notes and to mark assignments collected,
late, and exempt.

1. On the Tools menu, click Score Inspector, and then Assignments.

2. On the Scoresheet, click in the assignment column in the first empty cell next
to the appropriate student. In the Score Inspector, select the Collected hox
instead of entering a score. You can replace the check mark with a score
later. Mark a few more empty cells as Collected.

3. Click the Next arrow by the student name to move down to the next
student. Select the Late box.

4. Click the Next arrow to move down to the next student. Select the Missing
box.

5. Click the Next arrow to move down to the next student. Select the Exempt
Score box for one assignment. Exempt a few more of the empty cells.

6. Click the Next arrow by the assignment name to move to the next
assignment. Enter a comment in the Score Inspector. Note: The Clear button
on the Score Inspector clears the score completely, not just the comment or
a Collected check.

7. Click on the term grade for your assigned student. Use the Score Inspector
to enter a comment. Note the Reporting Term here:

(Later in the class you will look at your comments and the exempt indicator
in PowerSchool's parent portal.)

8. Click Close, and then click Save to retain the changes.

Reporting Features

There are eight types of reports available in PowerTeacher gradebook. They can be
produced in the following three file types:

* PDF - A cross-platform file that can be read and printed by Adobe Acrobat
Reader or Preview on a Mac or PC.

* HTML - A file that can be read by a browser such as Internet Explorer,
Firefox, or Safari.

* Text Export (CSV) - A text file consisting of the data, separated by commas.
This file can be opened with Excel or another spreadsheet software
application.

You can personalize each report by entering a custom title or by including a top
note, bottom note, and signature line.



The following table provides a brief description of each of the reports:

Attendance Grid

Student and date grid template for taking

attendance
Category Total Report Summarizes category totals
Final Grade and Comment Displays final grades and teacher comments by
Verification term

Individual Student Report

Displays a summary of the class activity per
student

Missing Assignment

Displays assignments that are missing per
assignment or per student

Scoresheet Displays a copy of the teacher’s gradebook

Student Multi-Section Report Includes grades from all of a student’s sections

Student Roster Displays demographic information by class

Activity 17 - Exploring the Reports

In pairs or small groups, look at the different types of reports. Create a report as a
PDF, in HTML, and as an Export (CSV) file, so you can experience the different
report output options.

1.

Click the Reports tab, and then click the type of report you would like to
view. The report options will become available in the lower pane on the
screen.

. Select the output option you would like. This is not necessary for the

Attendance Grid. Then, select the appropriate sections, students, sort order,
and date range for the report.

. Click the Layout tab. Enter a custom title, top note, bottom note, or

signature line.

. Click Run Report in the lower right corner of the screen.

. Select to Open the report or Save the report. If you choose Save, the report

will be saved in the output option and in the location you designate.



